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Introduction  
 
This tutorial is aimed at people who require a graphical logo for their site, but have no 
experience of graphical applications. 
 
For the purpose of this tutorial, we assume that you have MS Paint (Part of Windows) and 
some form of word processor installed on your machine. Linux users can use KolourPaint or 
GNU Paint (gpaint) as an alternative to MS Paint. 
 
Before we start producing any graphics, we first need to decide in what format our finished 
logo should be. Below is a brief introduction to several types of graphical file formats 
followed by recommendations for their application. 
 
 

 
JPEG (Joint Photographic Experts Group) 
 
JPEG: The Joint Photographic Experts Group format is one of the most popular 
formats for Web graphics. It supports 24 bits of colour information, and is most 
commonly used for photographs and similar continuous-tone bitmap images. The 
JPEG file format stores all of the colour information in an RGB image. JPEG was 
designed so that changes made to the original image during conversion to JPEG 
would not be visible to the human eye. 
 
Most imaging applications let you control the amount of compression performed on 
an image, so you can trade off image quality for smaller file size and vice versa. Be 
aware that the chances of degrading your image when converting it to JPEG increase 
proportionally with the amount of compression you use. 
 
 
 
GIF (Graphics Interchange Format) 
 
CompuServe originally developed the Graphics Interchange Format in 1987. It is 
most commonly used for bitmap images composed of line drawings or blocks of a 
few distinct colours. The GIF format supports 8 bits of colour information or less. 
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PNG (Portable Network Graphics) 
 
The Portable Network Graphics format will likely be the successor to the GIF file 
format. PNG is expected to become a mainstream format for Web images and could 
replace GIF entirely. It is platform independent and should be used for single images 
only (not animation). Compared with GIF, PNG offers greater colour support and 
better compression, gamma correction for brightness control across platforms, better 
support for transparency, and a better method for displaying progressive images. 
 
 
 
BMP (Windows bitmap) 
 
The Bitmap file format is used for bitmap graphics on the Windows platform only. 
Unlike other file formats the BMP format stores image data from bottom to top and 
pixels in blue/green/red order. Compression of BMP files is not supported, so they 
are usually very large. 

 
 
So what does all the above mean? Basically, the following rules should be adopted: 
 
 

1. For photo type images use the JPEG format. Save your master file without 
compression, but compress files uploaded to your site with as much 
compression as possible whilst keeping quality at an acceptable level. 

 
 

2. For logos and graphics use the PNG format where possible, if your graphic 
application does not support PNG then use the GIF format as an alternative. 

 
 

3. Due to their size BMP images should be avoided if possible, however, you 
may wish to create your logo or graphic in this format and then convert to a 
PNG or GIF to upload to your site.  
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Basic Logo 
 
Here we will create a simple image in paint. This method will probably not win any design 
awards, however it will get your site up and running. 
 
First open the paint application and set the image size through the attributes dialogue box – 
this can be found by clicking on ‘image’ in the menu bar and then ‘attributes’. 
  

 

 
Setting the image attributes 

 
 
 
We have set ours to 360 x 80 pixels, this size would work well with our eCommerce system. 
It is probably best to work with pixels as the unit size, however, inches or cm can be used if 
you are more comfortable with either of those units. 
 
Now that we have our drawing area set, we will start to create the logo. The following steps 
will give you an idea of what can be achieved in paint – you can make things as complicated 
or simple as you like. 
 
First we will create an ellipse, to make things a little easier we will magnify the view. This 
can be achieved by selecting ‘view’, then ‘zoom’ and finally ‘large size’. To draw the 
ellipse, select the ellipse tool (bottom left on the side bar) and then the first option of outline 
only – see screen dump below: 
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Enlarged view with ellipse outline tool selected 

 
 
Now move your cursor into the top left had corner of the drawing area, click the left mouse 
button down and drag the cursor downwards and to the right to create the ellipse. Once you 
are satisfied release the mouse button. 
 
Paint is not a particularly user-friendly application and it may take a few attempts to achieve 
the desired effect. If you are not happy with your initial effort, the ellipse can be removed by 
using the undo facility from the edit menu. Our ellipse is shown below: 
 
 

 
Completed ellipse 
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We are now going to create a further two ellipse – we could create them in the same way as 
the first, however, it is unlikely that we could get them all the same. To solve this problem 
we will cut and paste the first. 
 
Select box selection tool – dotted square at top right of tool bar. Then create a box enclosing 
the ellipse by clicking and dragging the cursor in a similar manner to the one you used to 
create the ellipse. Once you have the ellipse enclosed release the mouse button and press 
‘Ctrl + C’ to copy the ellipse, alternatively you can select copy from the edit menu. 
 
You now have a copy of the ellipse on the clipboard, press ‘Ctrl + V’ or select paste from 
the edit menu – this will drop a copy of the ellipse back into your drawing area. When the 
new image is pasted into the drawing area it will initially be movable. Click and hold within 
the limits of its enclosing box and you will be able to position the ellipse next to the first. 
 
Repeat this operation to insert a third ellipse. With the enlarged view and the ellipses all 
being identical it should be relatively easy to equally space them. Our three ellipses are 
shown below: 
 
 

 
Three equal ellipses  

 
 
 
Now that we have three outlines, we will fill them with colour. For this tutorial we will use 
red, green and blue. 
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Before we fill the first ellipse we need to set the foreground colour, left click on the red 
square of the colour palette at the bottom of the screen – this will set the foreground colour. 
Right clicking on a colour will set the background colour. Foreground and background 
colours are used as follows: 
 

Foreground colour is used for lines, borders of shapes, and text. 
 

Background colour is used to fill the inside of enclosed shapes and the background 
of text frames, and when you use the eraser. 
 
 

Now that the foreground colour is set, we can select the fill tool, this is the tipping paint can 
image below the box selection icon. The cursor will change to the fill icon, it is now a 
simple matter of clicking within the bounds of the ellipse to completely fill it with colour. 
 
 
Repeat the above step with green and blue selected as the foreground colours to fill the two 
remaining ellipses. Our filled ellipses are shown below: 
 

 
Ellipses with colouring  

 
 
 
Returning our image view to normal size by selecting ‘view’, then ‘zoom’ and finally 
‘normal size’ from the dropdown menu the ellipse will be as shown below: 
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Coloured ellipses shown at normal size 

 
 
Now we will add some text, we have used ‘Your Store’, but this could be your company 
name or site name. 
 
To add text select the text tool, this is the ‘A’ icon on the tool bar menu. Once you have 
selected the text tool, the background selection icon will appear below the tool menu (Blue 
cylinder, red sphere and green cube). Select the bottom option – this will produce text with a 
transparent background. 
 
With the text tool selected click and drag the cursor to create a boundary box in which the 
text will be created. Once created, the ‘Fonts’ tool bar will appear, if it fails to show, it can 
be selected from the ‘View’ menu – once selected it will appear every time a text boundary 
box is created. 
 
The text boundary box, background selection Icon and font tool bar are all shown in the 
following screen dump: 
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Text boundary box, background selection Icon and font tool bar 

 
 

Now type in your chosen phrase, we have entered ‘Your Store’. The font we have chosen is 
‘swis 721 BdOut Bt’ as this gives a non-filled font. To make the text a suitable size we have 
selected a 36 point font. 
 
All the variables for a font can be changed whilst the text is current – changes will be 
automatically shown on the screen. 
 
Once you are satisfied with the style of text, click outside of the text box to exit the text tool. 
Your text will now be complete. 
 
It is impossible to change the text once you have exited from the text tool. If you are not 
happy with the results, you must delete the text with the eraser and start again. 
 
As we have chosen a non-filled font it is possible to fill the letters with colour. This can be 
achieved in the same manner as the ellipses were coloured – with the fill tool. 
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Completed text 

 
 
Our filled coloured lettering is shown below: 
 
 

 

 
Completed text with colouring 
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That completes our basic logo. We are not suggesting that you copy the above for your logo, 
as it may not suit the style of your site.  
 
What we hope to have achieved here is to provide a basic introduction to the Paint 
application. Although the package is not particularly user friendly, with a bit of imagination 
combined with patience and practice a reasonable logo can be produced. 
 
If you are not that confident with your graphics application, it is possible to produce a 
reasonable logo just using the text function. This is discussed in the following section. 
 
 
 

Plain Text Logo 
 
A plain text logo could be entered directly into your site as a piece of formatted text, 
however, if you use a non-web safe font it is possible your logo will not display as 
anticipated. 
 
For example, if you have chosen to use Cataneo BT as your font, your logo will appear as 
follows to anyone with that font installed: 
 

������������������������	
	����	
	����	
	����	
	� ���
 
 
However, if a visitor loads your site and they have never installed that font on their machine, 
your logo will be displayed in a default font, such as Arial and appear to the visitor as: 
 

My Site Logo 
 
 
This problem can be avoided by creating your logo in paint and then saving as a graphic 
image. By doing this you will have full control over how the logo is displayed to all visitors. 
 
To create a plain text logo use the procedure for adding text as described in the previous 
section. 
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Below are some useful fonts for creating logos: 
 

 
���������	
	���������	
	���������	
	���������	
	� ���

Academy Engraved 
 

���������	
	���������	
	���������	
	���������	
	� ���
Bank Gothic  

���������	
	���������	
	���������	
	���������	
	� ���
Black Letter 

     
���������	
	���������	
	���������	
	���������	
	� ���

Broadway 
 ���������	
	���������	
	���������	
	���������	
	� ���

Calligraph 
 ���������	
	�

Comic Sans Ms 
     

���������	
	���������	
	���������	
	���������	
	� ���
Commercial Script 

 ���������	
	���������	
	���������	
	���������	
	 ��� �
Gothic 

 
���������	
	���������	
	���������	
	���������	
	� ���

High Light 
     

���������	
	���������	
	���������	
	���������	
	� ���

John Handy 
 

���������	
	���������	
	���������	
	���������	
	� ���
Jokerman 

 ���������	
	���������	
	���������	
	���������	
	����
Mekanik 

     
���������	
	���������	
	���������	
	���������	
	� ���

Milano 
 

M y Site LogoM y Site LogoM y Site LogoM y Site Logo    
Monotype Corsiva  ���������	
	���������	
	���������	
	���������	
	� ���

Odessa 
     

���������	
	���������	
	���������	
	���������	
	� ���
One Stroke Script 

 
���������	
	���������	
	���������	
	���������	
	� ���

Orange 
 

���������	
	���������	
	���������	
	���������	
	� ���
Park Avenue 

     
���������	
	���������	
	���������	
	���������	
	� ���
Quixley 

 
���������	
	���������	
	���������	
	���������	
	� ���
Rage Italic 

 
���������	
	���������	
	���������	
	���������	
	 ����

Vineta 
     

 
 
The above is only a small selection of all the fonts available, however, you may find that not 
all fonts are installed on your machine. 
 
The best approach is to experiment with different fonts until you find one that suits your 
logo. 
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Non-Graphic Applications 
 

For those that are familiar with other software applications there is a simple trick to produce 
a graphical logo, even if that application has no means of creating an image file. 
 
To demonstrate this concept we will use MS Word, Word has the ability to handle graphical 
data but has no means to save the information as an image file. 
 
First, we have opened word, created a new document and inserted a table with one row and 
two columns. We have set the table to fit the width of its contents and selected no borders. 
 

 

 
Word document with table 

 
 
Next we inserted an image into the first column of the table, our chosen image was a gear 
wheel. 
 
If you would like to include an image in your logo, but do not have one to hand, try 
searching on the Internet. Many are freely available from clip art galleries or alternatively 
they can be purchased for a relatively small fee from Fotoolia.com 
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Gear wheel inserted into first column 

 
 
The size of your chosen image may need adjusting, this can be done by selecting and 
dragging. This can be done at anytime in Word, this is one advantage of not working in 
paint. 
 
Next we have inserted a company name in the next column. For ours we chose the name 
‘Mechanical Engineering Services Limited’. We then set the colour to match the gear wheel, 
selected ‘Times new Roman’ as the font and enlarged it sufficiently to complement the gear 
wheel. We also left justified the text. 
 
Our results are shown below: 
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Word document with company name added 

 
 
Now comes the clever bit, select print preview as if you were going to print the document. 
This has the effect of removing the ghosted border of the table. 
 

 

 
Print preview of document 
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Now that we have an image on the screen of the desired logo, we can capture it by pressing 
the ‘alt’ and ‘Print Screen’ keys simultaneously. This will copy the screen image to the 
clipboard.  
 
Note, if you have a modern keyboard with alternative function key functions, you may need 
to experiment with the function lock key to get the print screen facility to work. 
 
Now open the MS Paint application and select ‘Paste’ from the edit menu. This will paste 
the captured screen image into the paint application, as shown below: 
 

 

 
Captured screen image 

 
 
Now that the image is in paint, it can be copied by using the selection tool and then pasted 
back into a new paint document. 
 
When using the selection tool it is best to keep as close to the logo so as to keep the margin 
to a minimum. However, to demonstrate another trick that can be employed in paint, we will 
be deliberately sloppy with our selection. 
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Selection line drawn around logo 

 
 

After selecting and copying the logo, open a new document in Paint by selecting ‘New’ 
from the ‘File’ menu. Then paste the copied image into the document. 

 
 

 
Pasted logo in new document 
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As you can see from our logo, the margins are too large. To reduce these, click on the blue 
dots at the middle of each edge, the cursor should change to directional arrows. With the 
mouse button held down, you can drag the edges of the image closer to the text. Blow is our 
image with the bottom and right hand margins reduced. 
 

 
Bottom and right hand margins reduced 

 
 
However, it is not possible to drag the top and left margins – this is where the next trick is 
useful. 
 
From the Image menu select ‘Flip and rotate’, this will open the flip and rotate dialogue box. 
 
 

 
Flip and rotate dialogue box 
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Select ‘Rotate by angle’ in the dialogue box and then, then the option becomes available, 
select ‘180º’. This will rotate the image by 180º, as shown below: 
 

 

 
Image rotated by 180º 

 
 
With the image rotated, it is possible to adjust the remain two margins: 

 
 

 
Logo with remaining two margins adjusted 
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Once the margins have been adjusted the rotate feature can be repeated to return the logo to 
its normal orientation, as shown below. 
 

 

 
Completed logo 

 
If you use the zoom function in paint (as described in the first section of this tutorial) with 
the above procedure it is possible to achieve very tight margins around your logo. 
 
We are not suggesting that the above is the best method of producing a logo, neither do we 
suggest that Word is the best application for producing a logo. What we have tried to 
demonstrate here, is that any application that you are familiar with can be used to create a 
logo, even if it is not a graphical package. 
 
That completes our introduction to logos and graphics. As with all our other tutorials, we 
encourage you to take the ideas here and experiment further. 
 
 

About us 
 

This tutorial has been produced by ProserveUK. A professional hosting company that provides 
affordable web hosting solutions. Large selection of plans available, one-month free trial 
offered on all plans. 
 

For more information, please visit www.proserveuk.com  
Or contact us as sales@proserveuk.com. 


